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[RAPID-PAIR USERS GUIDE v1.3] 
This user’s guide is intended for Rapid-Pair installation technicians. This guide is provided as a walk 
through for the installation and steps required to get started with the SCAN~LINK Rapid-Pair software 
and dongle. This guide will give an overview of all of the included features of Rapid-Pair along with 
procedures to use these features to effectively make adjustments during the commissioning of 
SCAN~LINK systems. 



2 
 

 

3450 LANDMARK RD., BURLINGTON, ONTARIO, CANADA L7M 1S8 
WWW.SCAN-LINK.COM   905-304-6100 | INFO@SCAN-LINK.COM 

 

Table of Contents 
Table of Figures ............................................................................................................................................. 4 

Overview ....................................................................................................................................................... 6 

Installing Rapid-Pair .................................................................................................................................. 6 

Rapid-Pair System Requirements ............................................................................................................. 6 

Rapid-Pair Installation ............................................................................................................................... 6 

.NET Installation .................................................................................................................................... 9 

.NET 2.0 / 3.5 Installation ...................................................................................................................... 9 

Driver Installation ................................................................................................................................ 10 

Manual Driver Installation .................................................................................................................. 11 

Win XP Silicon Labs Driver Installation ................................................................................................ 11 

Uninstalling Rapid-Pair ............................................................................................................................ 13 

Launching Rapid-Pair .................................................................................................................................. 14 

Rapid-Pair Overview................................................................................................................................ 14 

Connecting to the Rapid-Pair USB Dongle .............................................................................................. 16 

Pinging Nodes ......................................................................................................................................... 17 

Finding nodes .......................................................................................................................................... 18 

Node Information ............................................................................................................................... 19 

Selecting Nodes ....................................................................................................................................... 21 

Pairing Nodes .......................................................................................................................................... 22 

Unpairing Nodes ..................................................................................................................................... 25 

Updating Nodes ...................................................................................................................................... 26 

Rapid-Pair  Drop Down Menu ..................................................................................................................... 29 

File ........................................................................................................................................................... 29 

File -> Connect .................................................................................................................................... 29 

File -> Disconnect ................................................................................................................................ 29 

File -> Exit ............................................................................................................................................ 29 

Dongle ..................................................................................................................................................... 30 

Dongle -> Configuration Settings ........................................................................................................ 30 

Updating Configuration Settings ......................................................................................................... 33 

Dongle -> Node Discovery Settings ..................................................................................................... 33 

Node ........................................................................................................................................................ 34 



3 
 

 

3450 LANDMARK RD., BURLINGTON, ONTARIO, CANADA L7M 1S8 
WWW.SCAN-LINK.COM   905-304-6100 | INFO@SCAN-LINK.COM 

 

Node -> Log Data Manager ................................................................................................................. 35 

Log File Downloading Best Practices ................................................................................................... 40 

Node -> Date/Time Configuration ...................................................................................................... 41 

Node -> Upload Script ......................................................................................................................... 44 

Options .................................................................................................................................................... 46 

Options -> Rearrange Nodes ............................................................................................................... 46 

Options -> Retain Nodes ..................................................................................................................... 46 

Options -> Take Screen Capture ......................................................................................................... 46 

Options -> Message Window .............................................................................................................. 47 

Help ......................................................................................................................................................... 48 

Help -> User’s Guide ........................................................................................................................... 48 

Help -> Check for Updates .................................................................................................................. 48 

Help -> About ...................................................................................................................................... 51 

Help -> Indicator Codes ....................................................................................................................... 51 

Viewing a Node’s Properties ....................................................................................................................... 53 

Manually Validating a Node Property ..................................................................................................... 54 

Indicator Node Properties....................................................................................................................... 56 

Configuration Tab ............................................................................................................................... 56 

Installation Tab .................................................................................................................................... 59 

Security Tab ......................................................................................................................................... 60 

Antenna Node Properties ....................................................................................................................... 62 

Configuration Tab ............................................................................................................................... 62 

Installation Tab .................................................................................................................................... 64 

Operation Tab ..................................................................................................................................... 65 

Dual Node Operation Tab ................................................................................................................... 68 

Diagnostics Tab ................................................................................................................................... 69 

Dual Node Diagnostics Tab ................................................................................................................. 71 

Security Tab ......................................................................................................................................... 72 

 

 

 



4 
 

 

3450 LANDMARK RD., BURLINGTON, ONTARIO, CANADA L7M 1S8 
WWW.SCAN-LINK.COM   905-304-6100 | INFO@SCAN-LINK.COM 

 

Table of Figures 
Figure 1 - Rapid-Pair installer splash screen ................................................................................................. 7 

Figure 2 - Selecting an installation folder / access control / disk cost. ......................................................... 8 

Figure 3 - Windows XP node driver installation. ......................................................................................... 11 

Figure 4 - CP2102 USB to UART bridge controller driver installation. ........................................................ 12 

Figure 5 - Rapid-Pair Setup Wizard Window ............................................................................................... 13 

Figure 6 - Overview of main Rapid-Pair program window. ......................................................................... 14 

Figure 7 - Disconnected from dongle state. ................................................................................................ 16 

Figure 8 - Connected to dongle state. ......................................................................................................... 17 

Figure 9 - Manually Entering Node Mac Address ....................................................................................... 19 

Figure 10 - Selecting an antenna node in the main display area of Rapid-Pair. ......................................... 21 

Figure 11 - Pairing two SCAN~LINK nodes together. .................................................................................. 22 

Figure 12 - Update button has become active............................................................................................ 23 

Figure 13 - Unpaired Antenna and Indicator Node ..................................................................................... 24 

Figure 14 - Unpairing two paired Antenna and Indicator nodes with Rapid-Pair....................................... 25 

Figure 15 - Update button ready, link broken between two nodes. .......................................................... 26 

Figure 16 - Message box indicating an update was successful. .................................................................. 27 

Figure 17 – Message box indicating an update was unsuccessful. ............................................................. 27 

Figure 18 - Rapid-Pair drop down menu bar options. ................................................................................ 29 

Figure 19 - File Drop Down Menu ............................................................................................................... 29 

Figure 20 - Dongle Drop Down Menu ......................................................................................................... 30 

Figure 21 - dongle configuration window and current settings. ................................................................ 30 

Figure 22 - Confirm Network Key Prompt ................................................................................................... 32 

Figure 23 - Dongle Configuration Updated ................................................................................................. 33 

Figure 24 - Node Discovery Settings ........................................................................................................... 34 

Figure 25 - Node Drop Down Menu ............................................................................................................ 35 

Figure 26 - Log Data Manager Dialog Window ........................................................................................... 35 

Figure 27 - Save log data to file ................................................................................................................... 36 

Figure 28 - Create file window prompt ....................................................................................................... 37 

Figure 29 - Confirm Save As ........................................................................................................................ 37 

Figure 30 - Clear log file data. ..................................................................................................................... 39 

Figure 31 - Date/Time Configuration dialog window. ................................................................................. 41 

Figure 32 - Date/Time calendar date selector. ........................................................................................... 42 

Figure 33 - Upload script window. .............................................................................................................. 44 

Figure 34 - Options Drop Down Menu ........................................................................................................ 46 

Figure 35 - Rapid-Pair message window. .................................................................................................... 47 

Figure 36 - Help Drop Down Menu ............................................................................................................. 48 

Figure 37 - Rapid-Pair up to date ................................................................................................................ 48 

Figure 38 - Downloading latest version of Rapid-Pair................................................................................. 49 

Figure 39 - Ready to continue with upgrade. ............................................................................................. 50 

Figure 40 - Windows UAC prompt to update Rapid-Pair. ........................................................................... 50 



5 
 

 

3450 LANDMARK RD., BURLINGTON, ONTARIO, CANADA L7M 1S8 
WWW.SCAN-LINK.COM   905-304-6100 | INFO@SCAN-LINK.COM 

 

Figure 41 - Rapid-Pair updater message window shown. ........................................................................... 51 

Figure 42 - Indicator Code Window ............................................................................................................ 51 

Figure 43 - Entered Indicator Error Code .................................................................................................... 52 

Figure 44 - Invalid indicator code entered .................................................................................................. 52 

Figure 45 - Indicator node properties window. .......................................................................................... 54 

Figure 46 - Manual Parameter Validation Window .................................................................................... 55 

Figure 47 - Node properties installation tab shown. .................................................................................. 59 

Figure 48 - Indicator Node Security Tab ..................................................................................................... 60 

Figure 49 - Confirm Indicator Node Network Key ....................................................................................... 61 

Figure 50 - Antenna node configuration tab shown. .................................................................................. 62 

Figure 51 - Antenna Node Installation Tab ................................................................................................. 64 

Figure 52 - Antenna node operation tab shown. ........................................................................................ 65 

Figure 53 - Antenna node diagnostics tab shown. ...................................................................................... 69 

Figure 54 - Dual Node Antenna diagnostics tab shown. ............................................................................. 71 

Figure 55 - Antenna Node Security Tab ...................................................................................................... 72 

Figure 56 - Confirm Antenna Node Network Key ....................................................................................... 73 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

file://///MARLEXSERVER2/MRLXDat/DY/Eng/InHouseRandD/RFIDDET/Documentation/User%20and%20Technical%20Manuals/Rapid%20Pair%20User%20Manual/REV_1.3/SLRP-XXXX_UM_REV_1.3_GLOBAL_ENG_2021-07-22.docx%23_Toc77846458


6 
 

 

3450 LANDMARK RD., BURLINGTON, ONTARIO, CANADA L7M 1S8 
WWW.SCAN-LINK.COM   905-304-6100 | INFO@SCAN-LINK.COM 

 

Overview 
The Rapid-Pair software application is used for pairing and configuring SCAN~LINK antenna and 

indicator systems, as well as additional SCAN~LINK nodes.  This manual covers the installation 

and usage of the Rapid-Pair software, and how to configure SCAN~LINK node settings. 

Installing Rapid-Pair 

This section of the user manual covers the installation of the Rapid-Pair software on the 

computer system being used to configure SCAN~LINK nodes.  Before beginning the Rapid-Pair 

installation procedure, please ensure that the following system requirements are met. 

Rapid-Pair System Requirements 

- Windows XP / Vista / 7 / 8 / 8.1 / 10 

- 1 USB port 

- Rapid-Pair USB Dongle 

- CP210x Windows Driver (ZIC2410 / RF200) 

- FTDI Windows Driver (SS200 / SM200 / SN220) 

- Microsoft .NET 3.5 Framework 

- Internet connection (Rapid-Pair updates) 

Rapid-Pair Installation 

The Rapid-Pair installer package is available from the SCAN~LINK resources webpage.  Please 

consult with a SCAN~LINK representative for additional details on obtaining the latest 

installation package. 

The installation package is a .RAR archive which contains the Rapid-Pair setup file, along with 

additional dongle drivers as well as the required Microsoft .NET framework installation files.  

Once the installation package has been obtained, extract the contents of the installation 

package .RAR file to a directory on the target PC before continuing with the installation.  

Once the installation package has been extracted to a folder on the target PC, launch the Rapid-

Pair installer by double clicking on the file named 'Rapid-Pair Installer.msi'.  Depending on the 

version of Windows on the target PC, and the current security settings of the PC Rapid-Pair is 

being installed on, you may encounter a Windows security prompt after double clicking on the 

Rapid-Pair setup file.  Click the ‘Run’ button on this dialog box prompt to continue with the 

installation of Rapid-Pair if required. 

During the installation you may also be prompted with a dialog box which indicates that the 

“Microsoft .NET 3.5 Framework” is required to run Rapid-Pair.  Clicking the ‘Yes’ button will 

open the default internet browser and will navigate to a webpage where the required .NET 

framework installer file can be downloaded from.  An internet connection will be required to 
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proceed with the download.  To complete the installation of the required .NET framework, 

continue following the .NET framework installation instructions. 

If an internet connection is not available to download the required .NET framework installer 

file, please follow the instructions in the '.NET Installation' section of the user manual to install 

the .NET 3.5 Framework from the Rapid-Pair installation package. 

Once the required Rapid-Pair prerequisites have been installed successfully, re-run the 'Rapid-

Pair Installer.msi' installation file by double clicking on the file.  The first screen of the installer 

which appears is the splash screen and is shown below in Figure 1, click 'Next' to proceed. 

 

Figure 1 - Rapid-Pair installer splash screen 

Click 'Next' on the following screen to read the Rapid-Pair license agreement.  To continue with 

the Rapid-Pair installation, you must agree to the terms and conditions outlined in the end user 

license agreement.  Once you have agreed to the terms and conditions and clicked 'Next', the 

following screen will be displayed; as shown below in Figure 2.  This screen will allow you to 

choose a specific location to install Rapid-Pair to, as well as set user access control for the 

program.  By default, Rapid-Pair will install to the 'Program Files' directory.  If Rapid-Pair is 

installed on a 64-bit version of Windows, the default directory will be 'Program Files (x86)'. 
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To install Rapid-Pair to a location other than the default 'Program Files' directory, type in the 

desired directory or click the ‘Browse’ button and select the directory to install to.  If the 

computer that Rapid-Pair is being installed on has multiple users and accounts that require the 

use of Rapid-Pair, it is recommended to select the ‘Everyone’ radio button.  Clicking 'Disk Cost' 

will display the available space on local drives and the disk usage for Rapid-Pair. 

 

Figure 2 - Selecting an installation folder / access control / disk cost. 

During installation on Windows systems that have the UAC (User Account Control) enabled, a 

security prompt may be displayed by the system, and may indicate that "An unidentified 

program wants access to your computer" or "Do you want to allow the following program to 

make changes to this computer?".  To continue with the Rapid-Pair installation, grant access 

permissions to the application by clicking on either 'Allow', 'Yes' or 'Ok' in order to continue 

with the installation. 

The Windows UAC (User Account Control) may present additional security prompts to the user 

during installation.  Continue granting Rapid-Pair access permissions via any additional prompts 

in order to complete the installation.  If Rapid-Pair cannot be installed by the user due to 

insufficient access rights or privileges, please consult a system administrator for additional 

support. 
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.NET Installation 

The Rapid-Pair software requires the Microsoft .NET 3.5 Framework to be installed on the 

target PC the application intends to operate on.  Newer versions of Windows may not require 

the installation of the .NET 3.5 Framework since each Windows release prior to Windows XP is 

now pre-loaded with the latest version of the .NET Framework at the time of release.  Please 

consult the following table in order to determine whether the .NET 2.0 and .NET 3.5 

Frameworks will need to be installed on the target PC in order to use the Rapid-Pair software.  

Before installing any version of the Microsoft .NET framework, check the installed programs on 

the target PC for any .NET listings in order to determine if the required framework is already 

installed.  This can be done by navigating to the 'Control Panel', clicking on 'Programs and 

Features', and checking the list of programs installed on the target PC for the .NET frameworks 

that have been previously installed on the target PC.  

Windows 
Release 

Pre-Installed 
.NET Framework 

Version 

 
Required .NET Installation(s) 

XP - .NET Framework 2.0 and 3.5 installation required 

Vista 3.0 .NET Framework 3.5 installation required 

7 3.5 Installation not required. 

8 4.5 Installation not required. 

8.1 4.5.1 Installation not required. 

10 4.6 Installation not required. 

Table 1 - Microsoft Windows Pre-Installed .NET Framework 

.NET 2.0 / 3.5 Installation 

As outlined in Table 1 above, the .NET Framework v2.0 or v3.5 may be required to be installed 

on the target PC.  To install the .NET 2.0 Framework, double click on the file 'dotnetfx20.exe' 

found within the unzipped Rapid-Pair installation package in the folder which is named '.NET 

Framework'.  This will launch the installer for the Microsoft .NET 2.0 Framework.  Follow the 

installation instructions to complete the installation of the Microsoft .NET 2.0 Framework. 

In addition to the .NET 2.0 Framework, the .NET 3.5 Framework may be required for Rapid-Pair 

to operate on the target PC.  To install the Microsoft .NET 3.5 Framework, double click on the 

file 'dotNetFx35setup.exe' which can also be found within the unzipped Rapid-Pair installation 

package within the folder named '.NET Framework'. 

Once the installation procedures for the required Microsoft .NET Framework package 

prerequisites have been completed, Rapid-Pair should be run to determine if the required .NET 

Framework packages have been successfully installed on the target PC.  If Rapid-Pair fails to run 

after the required .NET Framework packages have been successfully installed, please consult a 

SCAN~LINK representative for additional details. 
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Driver Installation 

After successfully installing the Rapid-Pair software application and any required Microsoft .NET 

Framework prerequisites, a hardware driver will need to be installed on the target PC in order 

to use the accompanying dongle.  To begin the driver installation process, insert the dongle into 

one of the target PC’s USB ports.  A target PC running either Windows Vista, 7, 8, 8.1, or 10, will 

automatically try to find drivers for the dongle if there is an internet connection available. 

If the target PC is unable to install the appropriate driver automatically, please consult the 

following table to determine which driver installation package is required to be installed on the 

target PC in order for the dongle to function correctly with the Rapid-Pair software.  The 

required driver installation packages can be found in the unzipped Rapid-Pair installation 

package in the folder named 'Drivers'.  Consult Table 2 below for additional information on the 

drivers required for each supported dongle node. 

Dongle Node Vendor 
Driver 

Driver Name Installation File 

 
ZIC2410 
RF200 

 
Silicon 
Labs 

 
CP210x USB to UART VCP Driver 

Latest Version: v10.1.10 

32-bit Windows: 
CP210xVCPInstaller_x86.exe 

64-bit Windows: 
CP210xVCPInstaller_x64.exe 

 
SS200 
SM200 
SN220 

 

 
 

FTDI 

 
CDM v2.12.36.4 WHQL Certified 

Latest Version: v2.12.36.4 

Windows 7, 8, 8.1, 10: 
CDM212364_Setup.exe 

Windows XP, Vista: 
CDM21228_Setup.exe 

 

Table 2 - Required Rapid-Pair Node Drivers 

Updates to the node drivers may become available occasionally and are released by the driver 

vendors on the web.  To obtain the latest node driver for a dongle node, please visit the 

appropriate vendor website.  For additional information on installing the required Rapid-Pair 

node drivers, please consult a SCAN~LINK representative. 

The latest Silicon Labs Virtual COM port driver can be obtained from the following website:  

http://www.silabs.com/products/mcu/pages/usbtouartbridgevcpdrivers.aspx 

The latest FTDI Virtual COM port driver can be obtained from the following website: 

http://www.ftdichip.com/Drivers/VCP.htm 

 

http://www.silabs.com/products/mcu/pages/usbtouartbridgevcpdrivers.aspx
http://www.ftdichip.com/Drivers/VCP.htm
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Manual Driver Installation  

If the required node driver cannot be downloaded from the vendor website, the required 

dongle node drivers may be installed manually by the user via the provided node drivers that 

are packaged with the Rapid-Pair installation package.  All of the required node drivers can be 

found in the unzipped Rapid-Pair installation package directory named 'Drivers'.  Additionally, 

the dongle node drivers are grouped into two sub-directories named 'Silicon Labs', and 'FTDI' 

and both contain the required  node driver for either a Windows XP / Vista system or 

subsequent Windows 7, 8, 8.1 and 10 systems.  Please identify the Rapid-Pair USB node driver 

and Windows operating system by consulting Table 2 in order to select the appropriate node 

driver from the unzipped Rapid-Pair installation package.  Please consult the appropriate 

vendor driver installation documentation when installing any 3rd party drivers and software. 

Win XP Silicon Labs Driver Installation 

The Windows XP automatic hardware driver installation process is less streamlined than in 

subsequent versions of the operating system.  Therefore, the dongle hardware driver 

installation procedure is slightly different than the procedure detailed in the previous section 

which gives a generic installation overview for versions of Windows which were released 

subsequently after Windows XP. 

To begin the dongle driver installation process with a Windows XP target PC, insert the dongle 

node into the target PC's USB port.  You may now be prompted to choose how you want to 

install the drivers for the dongle as shown in Figure 3 below. 

 

Figure 3 - Windows XP node driver installation. 
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If the target PC is connected to the internet, select “Yes, this time only” and click 'Next'.  On the 

next screen that appears, select “Install and search for software automatically”.  Click ‘Finish’ if 

the driver search has completed searching and has successfully installed any drivers that were 

found for the dongle. 

As well, when the target PC is running Windows XP, a second set of drivers may also be found 

and will need to be installed.  The second driver installation prompt will be for the “CP2102 USB 

to UART Bridge Controller" hardware node, as shown below in Figure 4.  Please follow the same 

steps outlined for the previous driver installation procedure to install the required driver for 

this hardware node with Windows XP. 

 

Figure 4 - CP2102 USB to UART bridge controller driver installation. 

If the target PC does not have an internet connection or fails to automatically find and install 

the dongle drivers, the required driver installation package can be found in the unzipped Rapid-

Pair installation package.  Please consult Table 2 to determine the driver installation package 

that should be installed on the target PC.  Run the driver installation package and follow the 

installer instructions to complete the required node driver installation for the targeted dongle 

node. 

Note - It is recommended that the target PC be restarted after completing the installation of 

Rapid-Pair, the associated USB drivers and any required Microsoft .NET Framework packages. 
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Uninstalling Rapid-Pair 

Rapid-Pair can be removed from the target PC system by navigating to the following folder on 

the start menu: 'Scan-Link Technologies Inc' -> 'Rapid-Pair'.  This folder contains a shortcut 

named 'Uninstall' which can be clicked to uninstall the application from the host PC system.   

If Rapid-Pair is not currently running during an uninstall attempt, clicking on 'Uninstall' will bring 

up the following window as seen below in Figure 5.  With the Rapid-Pair Setup Wizard window 

visible, select the radio-box ‘Remove Rapid-Pair’ and then click on ‘Finish' to uninstall Rapid-

Pair.  If UAC (User Account Control) is enabled, a security prompt may be displayed when 

attempting to uninstall the application.  Click on ‘Allow’, 'Ok' or 'Yes' to continue. 

 

Figure 5 - Rapid-Pair Setup Wizard Window 

If Rapid-Pair is currently running during an uninstall attempt, a message box may be displayed 

that indicates the application is already running and that the operating system cannot run 

another instance of the application.  In this case, close down the instance of the Rapid-Pair 

application that was already running and attempt to uninstall the application again. 

Additionally, on newer versions of Windows, a different message box indicating that there are 

'Rapid-Pair Files in Use' may also be displayed.  This indicates that the Rapid-Pair application is 

already running and needs to be closed first before it can be uninstalled.  To proceed, close the 

instance of the Rapid-Pair application that is already running and click on the 'Try Again' button 

to proceed with uninstalling the application. 
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Launching Rapid-Pair 

This section of the user manual covers the steps required to connect to the dongle and provides 

an overview for using the Rapid-Pair application.  The dongle and Rapid-Pair software is used to 

pair SCAN~LINK antenna and indicator nodes together, as well as for configuring SCAN~LINK 

node parameters. 

To start Rapid-Pair, double click on the Rapid-Pair icon that appears on the Windows desktop.  

Rapid-Pair can also be started from the Windows start menu by navigating to the 'Scan-Link 

Technologies Inc.' folder and clicking on the Rapid-Pair shortcut. 

Rapid-Pair Overview 

A number of Rapid-Pair features will be presented in this section to help familiarize the reader 

with Rapid-Pair terms and the application’s capabilities.  Once the application has been 

launched, the main Rapid-Pair window will be displayed, as shown below in Figure 6. 

The Rapid-Pair main window can be maximized and minimized and closed at any time by using 

the buttons in the top right hand corner of the main window.  The Rapid-Pair main window can 

be resized by clicking and dragging the bottom right corner of the window.  Figure 6 below 

shows the items that may be present on the Rapid-Pair software user interface at any time 

during Rapid-Pair operation. 

 

Figure 6 - Overview of main Rapid-Pair program window. 
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1. Drop-Down Menu – This is the Rapid-Pair drop down menu.  This menu contains a 

number of features which are useful during Rapid-Pair operation.  The main categories 

of the drop down menu are ‘File’, ‘Dongle’, ‘Node’, ‘Options’, and ‘Help’.  More 

information can be found on the features of the drop down menu later in the user 

manual. 

 

2. Toolbar – This is the Rapid-Pair toolbar which contains a number of items that perform 

different operations.  From left to right, these items are the ‘Connect’ button, ‘Ping’ 

button, ‘Update’ button, 'Channel Filter' drop down selector, the 'Stop-All Ping' button, 

'Node Address' entry text box, 'Add Node' button and 'Remove Node' button.  These 

items will be explained in further detail later in the user manual.  By default, the 

'Channel Filter' drop down selector is set to channel four when Rapid-Pair runs. 

 

3. Main Node Display Area – This is the area in which Rapid-Pair will display any nodes 

that were found, along with any associated information when found during a ping 

query.  Nodes can be moved, paired/unpaired and clicked on in this area.  This area can 

contain many different types of SCAN~LINK nodes.  The SCAN~LINK nodes that will be 

emphasized throughout the manual are the SCAN~LINK antenna and indicator nodes. 

 

4. Indicator Node – This icon represents a SCAN~LINK indicator node that has responded 

to a Rapid-Pair ping query.  The node’s information can be seen below the indicator 

icon, which includes the node’s MAC address, channel, link quality, and the script name. 

 

5. Antenna Node – This icon represents a SCAN~LINK antenna node that has responded to 

a Rapid-Pair query.  The same information is presented below the antenna node icon as 

that which is displayed below the indicator icon.  Additional information regarding the 

type of RFID reader may be displayed below the antenna node icon. 

 

6. Status Messages – This area of the Rapid-Pair status bar will display status information 

updates regarding Rapid-Pair’s current state. 

 

7. Progress Bar – This bar displays the current operation’s progress towards being 

completed.  It will update during ping operations, update operations, and when reading 

a node’s properties. 
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Connecting to the Rapid-Pair USB Dongle 

Once the main Rapid-Pair window is displayed, the user is required to connect to the target 

dongle before communicating with any SCAN~LINK node.  This is done by clicking on the red 

button that appears on the far left hand side of the Rapid-Pair toolbar, as shown below in 

Figure 7.  Rapid-Pair can also connect to the dongle by clicking 'File'->‘Connect’ located in the 

Rapid-Pair menu toolbar. 

Once connected to a dongle, the 'Connect' button's color will turn green to indicate that the 

software has established a connection with a dongle.  Once connected to a dongle, the 

'Connect' button can be clicked on again to disconnect the Rapid-Pair software from a dongle.  

Rapid-Pair can also disconnect from a dongle by clicking 'File'->‘Disconnect’. 

When disconnected from a dongle, Rapid-Pair features will be grayed out and will not be 

available for use by the user.  When Rapid-Pair has established a connection with the dongle, 

the Rapid-Pair controls in the tool strip and menu items will become active. 

Note - It is important that a dongle is not removed from the system during Rapid-Pair operation.  

A communications error will occur if this event takes place, and Rapid-Pair will subsequently exit 

after displaying an error message. 

 

Figure 7 - Disconnected from dongle state. 
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Pinging Nodes 

The 'Ping Nodes' button will also become active as shown in Figure 8 below once Rapid-Pair has 

established a connection to a supported dongle, indicating that the dongle is now ready to 

query SCAN~LINK nodes.  As well, the status bar message will indicate that Rapid-Pair has 

successfully connected to the dongle.  The ‘Connect’ and ‘Disconnect’ menu items located 

within the ‘File’ drop down menu item will be enabled / disabled as Rapid-Pair connects and 

disconnects with a dongle. 

When connected to a dongle, the Rapid-Pair software will only display supported SCAN~LINK 

nodes that are within range and have responded to a ping query.  Once supported nodes have 

been located by Rapid-Pair, the will be queried automatically for additional information and 

then they will be added to the Rapid-Pair main display area.  Nodes can be pinged and located 

in three different ways, which will be discussed in the next section. 

 

Figure 8 - Connected to dongle state. 
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Finding nodes 

The first method for finding supported SCAN~LINK nodes is performed by specifying the 

channel that the nodes are operating on and subsequently transmitting a ping query on the 

selected channel.  This is accomplished by selecting the appropriate channel with the 'Channel 

Filter' drop down selector near the top of the window.  Clicking on the 'Ping Nodes' button will 

then issue a ping query on the selected channel.  Any supported SCAN~LINK nodes that have 

received and responded to the ping query on the selected channel will be queried for additional 

information and subsequently displayed in the main Rapid-Pair display area. 

This method works well when the channel that a SCAN~LINK node is operating on is known.  

Note that changing the channel in the 'Channel Filter' selection and pressing the 'Ping Nodes' 

button again will cause any nodes currently displayed in the main display area; which are on a 

different channel, to be removed from the Rapid-Pair main display area once the scan has 

completed.  Also, if a node was previously found on a channel and has moved out of range 

before the next ping query is performed, the out of range node will be removed from the 

Rapid-Pair main node display area since it was unable to respond to the ping query. 

The second method used to find nodes with the Rapid-Pair application involves searching all of 

the available channels in the 2.4 GHz band that the SCAN~LINK nodes may be operating on.  

The ‘All’ option can be selected in the 'Channel Filter' pull down selector if the channel(s) of the 

SCAN~LINK unit(s) to be found is unknown.  Clicking on the 'Ping Nodes' button will scan 

channels zero through fifteen, and any SCAN~LINK nodes found on these channels will be 

displayed in the main node display area of Rapid-Pair.  If the desired units have been found 

when using the ‘All’ option from the 'Channel Filter' drop down selector, but the channel scan 

has not completed, clicking the green ‘X’ button next to the 'Channel Filter' drop down selector 

will cancel the full channel scan and will return control of Rapid-Pair to the user.  Note that the 

'Channel Filter' will be set to the last channel scanned before the operation was cancelled. 

The third method used to find nodes with the Rapid-Pair software involves manually entering a 

node's MAC address into the 'Node Address' text box as seen below in Figure 9.  To use this 

method, enter the last three tuples of a node’s MAC address and then click on the green ‘add’ 

icon beside the 'Node Address' entry text box.  If the node is within range and on the same 

channel as the channel selected in the 'Channel Filter' drop down selector, only the node with 

the MAC address entered into the 'Node Address' text box will be added to the main display 

area of Rapid-Pair.  If the node could not be found, a message in the Rapid-Pair status bar will 

indicate that the node was not found. 

Note - If the ‘All’ option from the 'Channel Filter' drop down selector is selected when manually 

entering a node, all channels will be scanned for the specified node until the node is found. 
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To remove a particular node that is already present in the Rapid-Pair main display area, enter 

the node's MAC address that is displayed in the main node display area under the node's icon 

into the 'Node Address' text box and then click on the red 'Remove' icon.  The node will now be 

removed from the Rapid-Pair main display area. 

Note - Node MAC addresses can be quickly added to the 'Node Address' text box by first holding 

the control key down and then subsequently clicking on a node whose MAC address is desired to 

be placed into the 'Node Address' text box. 

 

Figure 9 - Manually Entering Node Mac Address 

SCAN~LINK nodes will also be removed from the main node display area when they are out of 

range or have failed to respond successfully to subsequent Rapid-Pair ping queries even when 

scanning for a single SCAN~LINK node. 

If no SCAN~LINK node(s) could be found on the current channel with either method of finding a 

node, a message indicating that “No Node(s) Found” will be displayed in the Rapid-Pair status 

bar. 

Node Information 

SCAN~LINK nodes that are displayed in the Rapid-Pair display area are accompanied by the 

MAC address of the node, channel the node is currently communicating on, the link quality 

between the node and the dongle, and the name of the firmware script the node is operating 

with.  As well, SCAN~LINK antenna nodes may display the type of RFID reader in use. 

MAC Address: 

The MAC address of the SCAN~LINK node is displayed under the node in the main node display 

area and is a unique identifier which is assigned during the commissioning of the SCAN~LINK 

node.  This unique address can be found on the serial number label of all SCAN~LINK products.  

The MAC address is used for wireless communication between nodes and Rapid-Pair. 

Nodes can be identified by their MAC addresses, which are displayed below the icon for each 

node in the main display area.  The MAC address that is shown below the nodes in the Rapid-

Pair main node display area will match the last six digits of the serial numbers on the antenna 

and indicator nodes. The serial number labels can be found on the bottom of the indicator node 

and on the side of the antenna node near the power cable. 
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Channel: 

The channel displayed under the node in the main node display area indicates the current 

frequency range that the node is transmitting on when communicating with Rapid-Pair and 

other SCAN~LINK nodes.  The channels range between zero and fifteen, and translate to 

channels eleven through twenty-six in the 2.4 GHz band under the 802.15.4 protocol. 

Link Quality: 

The link quality displayed under a node in the main node display area represents the signal 

strength of the last ping query response transmission.  The link quality value is colour coded to 

indicate whether the wireless communication is good (green), fair (amber) or poor (red).  This 

value depends on a number of different factors; however, the physical distance between the 

dongle and the node has the largest influence on link quality. 

Script Name: 

The script name displays the name of the current firmware image loaded on the SCAN~LINK 

node.  The reported script name may also indicate the version of the firmware image that is 

running on the node. 
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Selecting Nodes 

Nodes can be selected and moved around in the main node display area once they have been 

found by Rapid-Pair.  To select a node, place the mouse cursor over the node to be selected and 

click the left mouse button to select the node.  This will place a green circle around the node  to 

indicate that the node is now selected, as shown Figure 10 below. 

A node can be unselected by clicking anywhere in the main node display area that does not 

contain another node or by clicking on a different node.  Nodes that are displayed on top of one 

another in the main node display area of the Rapid-Pair window can be moved to another 

location by left clicking on the top most node and then dragging the selected node to a new 

position in the main display area. 

 

Figure 10 - Selecting an antenna node in the main display area of Rapid-Pair.  

Once a SCAN~LINK node has been selected, a number of different features can be used with the 

selected node, and some of these features require a node to be selected first.  These features 

will be detailed further throughout the remainder of the user manual. 

 

 



22 
 

 

3450 LANDMARK RD., BURLINGTON, ONTARIO, CANADA L7M 1S8 
WWW.SCAN-LINK.COM   905-304-6100 | INFO@SCAN-LINK.COM 

 

Pairing Nodes 

SCAN~LINK antenna and indicator nodes must be paired with each other to establish a wireless 

link between the two nodes.  Rapid-Pair allows nodes to be paired quickly by connecting nodes 

that are intended to communicate with each other via software.  Nodes that can be paired 

together are first found by Rapid-Pair and are displayed in the main node display area to allow 

the user to pair them together as required. 

Antenna to indicator node pairings; or vice versa, are currently the only type of node pairing 

that is permitted by SCAN~LINK nodes.  Pairing these types of nodes together is performed by 

right clicking on one of the two nodes that are intended to be paired to each other.  A green 

dashed circle will appear around the node that has been right clicked on to indicate that it has 

been selected to be paired with a target as shown below in Figure 11.  Another green dashed 

circle  will appear around an acceptable target node the mouse cursor has been placed on.  

Releasing the right mouse button over an acceptable target node will complete the process and 

pair the two nodes with each other.  Rapid-Pair will not allow an indicator node to be paired 

with any other indicator node.  Likewise, Rapid-Pair will also not allow an antenna node to be 

paired with another antenna node. 

 

Figure 11 - Pairing two SCAN~LINK nodes together. 
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After pairing two compatible nodes together, one red and one green line will appear between 

the two paired nodes to indicate that the two units are now paired with each other in Rapid-

Pair.   

 

Figure 12 - Update button has become active. 

Nodes that are already paired together when Rapid-Pair finds them via a ping query are shown 

with one green and one red line displayed between the antenna and indicator nodes that are 

paired together as seen previously in Figure 12.  For units not paired with another node, no 

lines will be connected to any other nodes as shown in Figure 13 below.   

A green link in the main Rapid-Pair window indicates that an antenna node has established a 

connection to an associated indicator node.  A red link indicates that an indicator node has 

established a connection to an associated antenna node. 
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Figure 13 - Unpaired Antenna and Indicator Node 

When either only a green or red line is present and connecting two nodes, this indicates that 

only one of the nodes has been paired with the other.  If this occurs, the node paired to the 

other will need to be unpaired with the node it is currently paired to, or the other node’s 

pairing will need to be corrected by pairing the nodes together again using the previously 

mentioned pairing procedure. 
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Unpairing Nodes 

To unpair SCAN~LINK nodes, hold the right mouse button down on a node that is already paired 

with another node and drag the mouse cursor to any empty space in the Rapid-Pair main 

display area, as shown below in Figure 14.  Release the right mouse button over the empty 

space to break the link between the two nodes.   

Note - If the link between any antenna and indicator node is broken, the solid green LED on the 

indicator node will begin flashing amber to indicate that the indicator node is not paired and is 

not receiving a heartbeat from the antenna node that it was previously paired with. 

Please note that a pairing action performed by the user for a node will override the previous 

pairing action performed by the user for the same node.  For example, if two nodes have been 

unpaired as seen below in Figure 15 and the ‘Update’ button has become active, pairing the 

two nodes again without first clicking on the ‘Update’ button will subsequently cause Rapid-Pair 

to pair the nodes with each other again if the ‘Update’ button is now clicked.  This has 

effectively cancelled the unpairing operation and has replaced it with a pairing operation.  Only 

the last pairing action will be applied to the nodes when the 'Update' button is clicked. 

 

Figure 14 - Unpairing two paired Antenna and Indicator nodes with Rapid-Pair. 
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Updating Nodes 

Configuration changes in Rapid-Pair are not applied to individual nodes until the 'Update' 

button has been clicked.  The ‘Update’ button will only become active once configuration 

changes have been made to any node(s).   

An active 'Update' button is shown below in Figure 15.  Clicking on an active ‘Update’ button 

will apply any pairing changes to the node(s), effectively setting or removing all pairings 

between the nodes.  Additional configuration settings that have been changed for each node 

will also be applied to the node(s) by using the 'Update' button.  Note that all nodes will be 

updated together during the update sequence if changes to multiple nodes have been made. 

 

Figure 15 - Update button ready, link broken between two nodes.  

When updating SCAN~LINK nodes, please ensure that the dongle is connected and secured with 

the computer USB port it is connected to, and also ensure that a good link quality exists 

between the dongle and the node(s) that are to be updated.  Do not unplug the dongle from 

the USB port during an update as this will result in Rapid-Pair failing to update parameters that 

have changed, or even result in corrupted data being written to a node.   

Once the update sequence has been completed successfully, a dialog box will be displayed to 

indicate whether that the configuration settings have been applied successfully as shown in 

Figure 16.  Following a successful update, Rapid-Pair will attempt to reboot any SCAN~LINK 
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node(s) automatically if a parameter has been changed which requires a node reboot in order 

to take effect.  After a successful update, the user should verify whether the configuration 

changes were applied successfully by reading back and checking whether the configuration 

settings or pairing changes have been set to the intended states. 

 

Figure 16 - Message box indicating an update was successful. 

Rapid-Pair will attempt to update each configuration parameter that has changed up to three 

times during the update sequence.  Additional retry attempts may occur if communication with 

any node(s) to be updated is lost or interrupted during the update sequence.  Retry attempts 

may also result due to wireless channel interference due to a third party wireless node 

interfering with Rapid-Pair wireless traffic during the parameter update sequence. 

After three retry attempts, Rapid-Pair will stop trying to update the current configuration 

parameter and advance to the next configuration parameter that is to be updated.  Once Rapid-

Pair has completed the update sequence, all of the parameters which could not successfully be 

updated will be displayed in a message box prompt as seen below in Figure 17.  If this message 

box is received, additional update requests will need to be made to update the parameters that 

could not be updated. 

 

Figure 17 – Message box indicating an update was unsuccessful. 

Ensure that a strong wireless link exists between the dongle and any node(s) requiring 

parameter updates before attempting to update any node(s) for which configuration 

parameters have been changed.   
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Note - When SCAN~LINK antenna and indicator nodes are paired, the status LED on the 

indicator node (amber blinking light) should turn solid green once the node pairings are applied, 

updated and the nodes have been rebooted.  If the status LED does not turn green, the power 

may have to be cycled on the SCAN~LINK system.  If this LED is still not green after a power 

cycle, ping the nodes again with Rapid-Pair and verify that the nodes are paired properly. 
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Rapid-Pair  Drop Down Menu 
This section describes the options available within the drop down menu bar available at the top 

of the Rapid-Pair main program window as seen below in Figure 18.  A description of each drop 

down menu option will be discussed in this section of the manual. 

 

Figure 18 - Rapid-Pair drop down menu bar options. 

File 

Clicking on the ‘File drop down menu item in the Rapid-Pair application menu bar will display a 

list of additional options that are available in Rapid-Pair.  This list of additional drop down menu 

options currently includes 'Connect', 'Disconnect' and 'Exit' as seen below in Figure 19. 

 

Figure 19 - File Drop Down Menu 

File -> Connect 

Clicking on this sub menu option will cause Rapid-Pair to perform a connection attempt with 

the dongle. 

File -> Disconnect 

Clicking on this sub menu option will cause Rapid-Pair to perform a disconnection attempt with 

the dongle. 

File -> Exit 

Clicking on this sub menu option will exit the Rapid-Pair application.  All configuration settings 

not currently applied (by clicking the green ‘Update’ button) will be lost.  Rapid-Pair will also 

automatically disconnect from the dongle.  Clicking on the 'Exit' drop down menu item under 

the 'File' drop down menu has the same effect as closing a Windows application in the 

traditional way by clicking on the 'X' in the upper right hand corner of the main Rapid-Pair 

window.  
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Dongle 

Clicking on the ‘Dongle’ drop down menu item in the Rapid-Pair application menu bar will 

display a list of additional dongle options that are available.  This list of additional drop down 

menu options currently includes the 'Configuration Settings' and 'Node Discovery Settings' 

options as seen below in Figure 20. 

 

Figure 20 - Dongle Drop Down Menu 

Dongle -> Configuration Settings 

Clicking on the 'Configuration Settings' sub menu option will open a dialog box as shown in 

Figure 21 below.  This dialog window allows the user to change the configuration settings of the 

dongle that the Rapid-Pair application is currently connected to.   

dongles are pre-configured with factory default settings that are compatible with additional 

SCAN~LINK node nodes.  Therefore, it is recommended not to change the pre-configured 

dongle configuration parameters that are available through the 'Configuration Settings' dialog 

window.  Please note that this feature is intended to only be used by advanced SCAN~LINK 

technicians. 

  
 

Figure 21 - dongle configuration window and current settings. 
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Build Date: 

This field indicates the date that the dongle software was released on. 

Version: 

This field indicates the current software version of the dongle.  As software updates may 

become available, this field can be used to check whether the dongle software is outdated and 

should be updated. 

MAC Address: 

The dongle MAC address is a unique address that is used to communicate with additional 

SCAN~LINK nodes.  These MAC addresses are a globally licensed unique ID and should not be 

changed from their factory default value.  Changing the MAC address could potentially cause 

communication problems with the SCAN~LINK system or any surrounding SCAN~LINK nodes 

that may already be using the same MAC address as the dongle.  Please note that this 

configuration parameter is intended for advanced users only. 

Node Name:  

This field may be changed for the user's convenience in order to identify dongles by name.  This 

field has no affect on the operation of the SCAN~LINK system.  Spaces are not permitted as part 

of the node name. 

Network ID:  

This parameter changes which network the dongle will operate on.  Nodes operating on the 

same channel but with different network IDs will not be able to communicate with each other.  

Likewise, the dongle will not be able to communicate with SCAN~LINK nodes that have different 

network IDs than that of the dongle, regardless of whether the dongle and the nodes are on the 

same channel.  If Rapid-Pair cannot communicate with a node because it is on a different 

network, the dongle can be configured to communicate with that particular node by changing 

the network ID of the dongle by changing this configuration parameter.  Please note that this 

configuration parameter is intended for advanced users only. 

Radio Rate: 

The wireless data transmission rate of a SCAN~LINK node can be set to operate at a number of 

different data rates.  Like the network ID parameter, the dongle will not be able to 

communicate with a node unless the communication rates are configured with the same value 

on each node.  The default radio rate setting for dongles and SCAN~LINK nodes is configured to 

a radio rate of 250 kbps, as shown previously in Figure 21.  The radio rate of the dongle will not 

be remembered once the dongle is removed from the system.  Please note that this 

configuration parameter is intended for advanced users only. 
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Network Key: 

Additional security and advanced encryption features have been added to the next generation 

of the SCAN~LINK platform and Rapid-Pair.  The network key configuration parameter allows 

the user to enter a secret key that will be used by the dongle in order to communicate with 

additional SCAN~LINK nodes that support the additional security.  Nodes that support 

additional security are only able communicate with other SCAN~LINK nodes that support the 

same security features.  SCAN~LINK nodes that do not support additional security cannot 

communicate with nodes that do support the additional security. 

Each SCAN~LINK node that supports the additional security features uses a pre-defined default 

network key.  The network key must be set to the same key value on all nodes that are required 

to communicate with each other.  If the dongle supports the additional security features, the 

default key will be used by the Rapid-Pair application to communicate with nodes on a 

particular channel and network.  The network key feature will not be available to use with 

SCAN~LINK hardware that does not support the additional security features. 

Once the dongle network key has been changed, the dongle will no longer be able to 

communicate with any nodes that do not have the same network key.  If the user intends on 

using a different network key other than the default key for a SCAN~LINK antenna and indicator 

node pair, the network key will need to be changed on the nodes first.  Once the network key 

has been changed on the nodes, the user will need to change the network key that the dongle 

is using in order to continue communicating with the nodes that have had their network key 

changed from the default key value. 

To change the dongle network key, click in the 'Network Key' textbox field and enter a new key 

value.  The new network key may consist of up to thirty-one keyboard characters.  If a new 

network key value has been entered into the textbox field and the 'Accept' button in the dialog 

window is clicked, a prompt will be displayed indicating that the network key has changed, as 

seen below in Figure 22. 

 

Figure 22 - Confirm Network Key Prompt 
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The prompt window, shown previously in Figure 22 is displayed in order to prevent the user 

from unintentionally changing the network key.  Clicking 'Yes' on the 'Confirm Network Key' 

dialog box window will cause the dongle to update the network key that it is currently using.  

Note that the dongle will remember the last network key value that was entered even after the 

dongle has been unplugged from the system.   

Note - There is currently no way to recover a network key if it is lost, therefore it is left up to the 

user to keep track of any network keys that have been assigned to SCAN~LINK nodes and 

dongles.  Please contact a SCAN~LINK representative if an assigned network key has been lost. 

Updating Configuration Settings 

Once any dongle configuration settings have been changed, clicking the 'Accept' button will 

immediately update the dongle with the configuration parameter setting changes that have 

been made.  Clicking the 'Cancel' button will discard all dongle parameter configuration changes 

that have been made and return the user to the main Rapid-Pair window.  If the dongle 

configuration changes were successful, a dialog box will be displayed as shown below in Figure 

23 which indicates that the dongle configuration settings were applied successfully. 

 

Figure 23 - Dongle Configuration Updated 

 

 

 

 

 

 

Dongle -> Node Discovery Settings 

Clicking on the 'Node Discovery Settings' option from the menu toolbar will open a dialog box as 

shown in Figure 24 below.  This dialog box allows the user to make changes to some of the 



34 
 

 

3450 LANDMARK RD., BURLINGTON, ONTARIO, CANADA L7M 1S8 
WWW.SCAN-LINK.COM   905-304-6100 | INFO@SCAN-LINK.COM 

 

parameters that Rapid-Pair uses when performing node discoveries when attempting to find 

SCAN~LINK nodes.  These parameters can be changed by clicking and dragging the track-bar 

position indicator for each configuration parameter to the desired value.  The values of each of 

the track-bar ticks will appear under each slider tab. 

 

Figure 24 - Node Discovery Settings 

Reply Window Duration: 

This parameter adjusts the maximum amount of time that Rapid-Pair will wait for nodes to 

respond to a discovery message and specifies the maximum amount of time that a node has to 

respond to a discovery message.  Adjust this parameter to larger values when many nodes are 

expected to respond to a Rapid-Pair node discovery request and adjust this parameter to lower 

values to speed up the node discovery process when fewer nodes are expected to respond to a 

Rapid-Pair discovery request.  Setting this parameter to a lower value will cause the node 

discovery process to be quicker, however more collisions may take place if many nodes attempt 

to report back to Rapid-Pair within a smaller reply window.  For general use, set this parameter 

to a lower value when attempting to find a small number of nodes, and set this parameter to a 

higher value to reduce the number of collisions that may occur when many nodes are expected 

to report back to Rapid-Pair during the node discovery process. 

Time-To-Live:  

The time-to-live setting adjusts the number of hops that a node discovery message is allowed to 

take on the wireless network between nodes.  Typically this parameter is used to limit the 

lifetime of a discovery message on a network to prevent it from circulating indefinitely.  It is 

recommended that this parameter not be adjusted for typical Rapid-Pair usage. 

Node 

Clicking on the ‘Node’ drop down menu item in the Rapid-Pair program tool bar menu will 

display a drop down list of additional node options available in Rapid-Pair.  This list of additional 
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drop down menu options currently includes the 'Log Data Manager', 'Date/Time Configuration' 

and 'Upload Script' options as seen below in Figure 25. 

 

Figure 25 - Node Drop Down Menu 

Node -> Log Data Manager 

This feature can only be used with a SCAN~LINK antenna node that has been selected within 

the Rapid-Pair main display area.  Once an antenna node has been selected, clicking on the 'Log 

Data Manager' option within the 'Node' drop down menu will open a dialog window as seen 

below in Figure 26.  This dialog window allows a user to download log data from a SCAN~LINK 

antenna node and save it in a variety of file formats.  As well, the 'Log Data Manager' dialog 

window allows a user to clear the available log files which are stored on a remote SCAN~LINK 

antenna node. 

Note – Downloading log data is only available with version 1.1 of the SCAN~LINK dongle.  Please 

upgrade the dongle to this version or contact a SCAN~LINK representative for more information 

on upgrading the dongle to enable this feature. 

 

Figure 26 - Log Data Manager Dialog Window 

MAC Address:  

The MAC address field displays the MAC address of the node which is to be queried for log 

data.  The MAC address of the node can be found on the serial number label on the node to be 

queried. 
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Channel:  

This parameter is used to set the channel on which the log data download will take place.  The 

channel value set here must match the operating channel of the antenna node that the log data 

is to be downloaded from. 

Log File:  

Before the log data can be downloaded, the user must specify the name of the log file the log 

data will be saved to.  Clicking on the ‘Save’ button will open another dialog window as shown 

below in Figure 27.  Entering a name which corresponds to the remote antenna node's name 

and date of download may be helpful when identifying the log data file at a later time.  If the 

file does not currently exist on the system, a prompt will appear as shown below in Figure 28 

asking the user whether the file should be created.  Once a file has been selected or created to 

save the log data to, the ‘Download’ button will become active on the 'Log Data Manager' 

dialog window. 

 

Figure 27 - Save log data to file 
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Figure 28 - Create file window prompt 

If the file already exists, another window prompt will appear asking the user to overwrite the 

existing file as seen in Figure 29 below.  By default, all Rapid-Pair downloaded log data is saved 

as a .log file.  A ‘.log’ file contains the raw log messages that have not been decoded into a 

human readable format. 

 

Figure 29 - Confirm Save As 

Output:  

The output options allow the user to specify the output format of a downloaded log file.  The 

two options currently available are ‘Output Readable’ and ‘Output CSV'.  By default, the ‘Output 

Readable’ checkbox is only selected. 

‘Output Readable’ – Selecting this option will cause Rapid-Pair to decode and output the 

downloaded log file to a human readable log file format.  The output file will be created with 

the same name specified for the ‘.log’ file; however the file will be saved with ‘.txt’ as the file 

extension. 

‘Output CSV’ – Selecting this option will cause Rapid-Pair to decode and output the 

downloaded log file to a comma separated value log file format in human readable form.  The 

output file will be created with the same name specified for the ‘.log’ file; however the file will 

be saved with ‘.csv’ as the file extension. 

Select Log:  

The select log drop down selector box allows the user to select which log data file to download 

from the remote SCAN~LINK antenna node.  Currently there are two log files available that can 

be downloaded from remote antenna nodes. 
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‘Detection Log’ – The detection log contains messages related to the detection of tags by the 

antenna node.  The main purpose of the detection log is to provide a record of the times that 

RFID equipped SCAN~LINK apparel was detected by the antenna node.  As well, this log also 

keeps track of many additional events that pertain to the apparel scanning process.  Selecting 

this log for download will cause Rapid-Pair to download the log data that is present in the 

'Detection Log' file on the remote antenna node.   

‘System Log’ – The system log contains records related to the operation of the antenna node as 

well as any errors that may have occurred during operation.  The system log contains valuable 

information for service personnel and is a handy resource for troubleshooting a malfunctioning 

antenna node.  Selecting this log for download will cause Rapid-Pair to download the log data 

that is present in the antenna node's 'System Log' file on the remote antenna node. 

Progress: 

The progress bar will show the completion status of the log downloading operation once the 

download has started.  Clicking the ‘Cancel’ button beside the progress bar during the log file 

download will stop the current log data download.  Cancelling the log file download will also 

prevent Rapid-Pair from outputting any downloaded log data to the selected output files. 

Status: 

The status information parameter will display the current status of the log file download once 

the download has been started.  Check this status information parameter to determine if the 

log file download was successful or failed due to an error.  Any errors that have occurred with 

the operation will be displayed here as well. 

Download Button: 

The ‘Download’ button will become active once the MAC address, channel and output files to 

save to have all been entered/specified.  Clicking this button once it has become active will 

cause Rapid-Pair to attempt to download the log file specified in the ‘Select Log’ drop down 

selection box.  Once the log file download completes successfully, or the download is cancelled 

by clicking on the ‘Cancel’ button, the ‘Download’ button will become inactive again. 

Clear Log Button: 

The ‘Clear Log’ button allows the user to clear the log data present in the log specified by the 

‘Select Log’ drop down selection box.  Only a MAC address and channel are required to be 

entered to clear a log file from a remote antenna node.  A warning prompt will be issued to the 

user before clearing the log data as shown below in Figure 30. 
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Figure 30 - Clear log file data. 

Clicking on ‘Yes’ will cause Rapid-Pair to attempt a clearing of all log data from the log specified 

by the ‘Select Log’ drop down selection box.   

Note – Log data is permanently cleared once this operation completes successfully and can no 

longer be recovered.   

Close Button: 

The ‘Close’ button will close the ‘Log Data Manager’ dialog window and return the user to the 

main Rapid-Pair window.  Once a log download operation has started, this button will become 

inactive to prevent the user from closing the dialog window while the log data is downloading. 
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Log File Downloading Best Practices 

Once all of the log file dialog window parameters have been specified and the 'Download' 

button has been clicked, Rapid-Pair will begin downloading the selected log file over the 

specified wireless channel.  During this time the remote antenna node that the log file is being 

downloaded from will be placed into a download mode that allows the remote antenna node to 

process log requests from Rapid-Pair.  Once a remote antenna node is placed into this mode, it 

will cease scanning for any SCAN~LINK apparel and the internal diagnostic tag. 

Note - A remote antenna node should not be used for regular operations while Rapid-Pair is 

downloading log file data from one of the node's log files. 

Since a particular wireless channel may be shared by multiple SCAN~LINK nodes, wireless 

collisions are possible during the transmission of communication messages between indicator 

and antenna pairs.  When a log file is being downloaded, much of the channel's bandwidth is 

utilized during the operation.  During this time, SCAN~LINK nodes that are sharing the same 

channel over which log downloads are taking place may experience intermittent wireless 

communication.   

It is recommended that Rapid-Pair log file downloads take place on a separate channel that is 

free of additional SCAN~LINK nodes.  This will help minimize the effect of Rapid-Pair's wireless 

log downloading operation from interfering with additional SCAN~LINK antenna and indicator 

pairs that may be transmitting on the same wireless channel.  As well, downloading log data on 

a channel that is free of other SCAN~LINK nodes will help prevent log file download operations 

from failing due to interference from additional SCAN~LINK nodes. 

Please follow the steps outlined in the following sections of the user's manual for placing a 

remote antenna node into a separate channel for log file downloading. 
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Node -> Date/Time Configuration 

This feature can only be used with a SCAN~LINK antenna node that has been selected within 

the Rapid-Pair main display area.  Once an antenna node has been selected, clicking on the 

'Date/Time Configuration' option will open a dialog window as seen below in Figure 31, which 

allows a user to set a remote antenna node’s real time clock with the current date and time.  

This dialog window will also allow a user to read back the date and time that a remote antenna 

node’s real time clock is currently set to. 

Note - The real time clock is used for time stamping entries in both the detection and system log 

file of an antenna node.  It is important that the real time clock is updated with the current time 

and date of the geographic region the antenna node is intended to operate within. 

  

Figure 31 - Date/Time Configuration dialog window. 

MAC Address: 

The MAC address field displays the MAC address of the node which is to have its real time clock 

updated or queried.  The MAC address of the node can be found on the serial number label on 

the node to be queried. 

Channel: 

This parameter is used to set the channel on which the time query is to be performed on.  The 

channel value set here must match the operating channel of the node the remote antenna 

node is currently operating on.  The procedures recommended in the best practices for 

downloading log files section of the user's manual also apply when updating or querying the 

antenna node's real time clock. 

Date/Time: 

The 'Date/Time' drop down selection menu displays the current date/time that is to be set on a 

remote SCAN~LINK antenna node's real time clock.  Clicking on the drop down arrow in this box 
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will display a calendar which the user can use to select the current date as shown below in 

Figure 32. 

  

Figure 32 - Date/Time calendar date selector. 

The time that will be used to update the remote antenna node’s real time clock can be changed 

by clicking on the hour, minute or seconds displayed in the drop down selection menu box.  

Once selected, the value can be changed by using the up/down arrow keys on the keyboard to 

increase or decrease the value. 

Reset Date/Time Button: 

The ‘Reset Date/Time’ button will reset the ‘Date/Time’ drop down selection menu box 

contents to the current date and time settings that the PC running Rapid-Pair is set to.  Note 

that the current time is also based on the PC's current time zone settings.  This feature is useful 

for updating the remote antenna node’s real time clock with the most up-to-date time settings. 

Status: 

The status information parameter will display the current status of the set/query remote 

antenna node's real time clock operation.  Any errors that have occurred with the operation will 

be displayed here as well. 

Set Clock Button: 

The ‘Set Clock’ button will update the remote antenna node with the date and time specified in 

the ‘Date/Time’ drop down selection menu box.  The result of the operation will be displayed as 

part of the status information.  This button will become inactive while Rapid-Pair is performing 

a remote set clock operation. 
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Read Clock Button: 

The ‘Read Clock’ button will read back the current date and time settings that the remote 

antenna node's real time clock is currently set with.  The result of the operation and any errors 

that have occurred during the operation will be displayed as part of the status information 

output message.  This button will become inactive while Rapid-Pair is performing the remote 

read clock operation. 

A successful remote antenna node real time clock read operation will return the date and time 

as well as an indication as to whether the real time clock on the remote node has been stopped 

since it was last set.  The real time clock stopped information is important for verifying whether 

the time stamps present within the detection or system log files are accurate.  If the status 

message indicates that the real time clock was stopped during operation, than resetting the 

real time clock date and time settings will reset the real time clock and the status message 

which indicates that the real time clock stopped. 

Close Button: 

The ‘Close’ button will close the ‘Date/Time Configuration’ dialog window and return the user 

to the main Rapid-Pair window.  Date and time settings that have not been applied to a remote 

antenna node will not be applied to the remote antenna node. 
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Node -> Upload Script 

Updates may become available from time-to-time that add additional functionality to 

SCAN~LINK nodes or patch any bugs that have been discovered and this Rapid-Pair feature 

provides the means for updating a node’s firmware image. 

This feature can only be used with a SCAN~LINK antenna or indicator node that has been 

selected within the Rapid-Pair main display area.  Once an antenna or indicator node has been 

selected, clicking on the 'Upload Script' feature will open the upload script window as shown 

below in Figure 33.  Please note that this feature is intended for advanced SCAN~LINK service 

technicians only and improper use of this feature may lead to improper node operation or even 

node failure.  Note that this feature is only available for advanced SCAN~LINK technicians and 

must be enabled by a SCAN~LINK representative.  For additional information regarding this 

feature, please consult a SCAN~LINK technician. 

 

Figure 33 - Upload script window. 

MAC Address: 

The MAC address field displays the MAC address of the node that will have its firmware image 

updated by Rapid-Pair.  The MAC address of the node can be found on the serial number label 

on the node to be updated. 

Channel:  

This parameter is used to set the channel on which the firmware upgrade will take place.  The 

channel value set here must match the operating channel of the node being upgraded. 
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Script Name: 

This parameter indicates the name of the script that has been selected to be uploaded to the 

remote node.  Clicking on the ‘Open’ button beside this parameter will allow the user to select a 

binary image to upload to the remote node.  Only SCAN~LINK approved binary firmware images 

should be uploaded to a remote node and only the binary images that are intended for a 

specific SCAN~LINK node should be uploaded to a node.  Note that Rapid-Pair will not prevent a 

user from uploading a binary image that is not intended for a specific node.  It is left up to the 

user to ensure that the proper firmware image file is uploaded to a node it is intended for. 

CRC: 

The CRC (Cyclic Redundancy Check) is used to display the current checksum value of the 

selected binary image.  This value will be checked with the CRC on the node to ensure that the 

upload was successful to determine if any errors occurred during transmission. 

Progress: 

The progress bar will show the status of the upload once an upload has been started.  Clicking 

the ‘Cancel’ button beside the progress bar during the upload will stop the current binary image 

upload and Rapid-Pair will attempt to erase the partially transmitted file from the node.  

Status: 

The status information parameter will display the current status of the file upload once the 

upload has started.  Check this status information message to determine if the upload failed or 

was successful. 

Upload Button: 

The ‘Upload’ button will become active once the MAC address, channel and binary image have 

been selected.  The program will attempt to upload the binary image to the node once the 

‘Upload’ button has been pressed.  This button can only be pressed once per upload.  If the 

upload fails or was cancelled by the user, the binary image must be selected again before the 

‘Upload’ button will become active again. 

Cancel Button: 

The ‘Cancel’ button will become active once the ‘Upload’ button has been pressed, and will 

allow a user to cancel the upload operation.  Clicking on the ‘Cancel’ button during an upload 

will cause Rapid-Pair to stop the current upload and attempt to erase the partially uploaded file 

from the remote node.  Clicking on the ‘Cancel’ button during an upload will result in the node 

becoming unusable.  As well, any uploads that are interrupted will result in a node that is 

unusable.  All nodes that are upgraded via the binary firmware image uploading feature must 

be tested to ensure that the node is functioning properly.  If the ‘Cancel’ button is pressed 

during an upload, the SCAN~LINK node will default to channel four if the remote node is 

rebooted or power cycled without a firmware image loaded. 
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Options 

Clicking on the ‘Options’ drop down menu in the Rapid-Pair program tool bar menu will display 

a drop down list of additional options available in Rapid-Pair.  This drop down list of additional 

features includes 'Rearrange Nodes', 'Retain Nodes', 'Take Screen Capture', and 'Message 

Window' options as seen below in Figure 34. 

 

Figure 34 - Options Drop Down Menu 

Options -> Rearrange Nodes 

This feature can be used to re-arrange the locations of any SCAN~LINK nodes within the main 

display area.  This feature can also be used if nodes are lost when adjusting the size of the main 

window.  Selecting this feature will return all nodes to the confines of the main display area. 

Options -> Retain Nodes 

This feature can be enabled to prevent Rapid-Pair from removing SCAN~LINK nodes from the 

main node display area after an unsuccessful ping.  This feature is useful when many 

SCAN~LINK nodes are operational within a small region when all nodes are trying to reply to a 

Rapid-Pair ping query.  When many nodes receive a Rapid-Pair ping query simultaneously, the 

probability of nodes colliding during the wireless reply is higher.  Therefore trying to find all of 

the nodes in a noisy environment can be difficult when having to re-ping nodes in an attempt to 

find all of the nodes in an environment.  Enabling this feature can help by causing Rapid-Pair to 

remember all nodes that have been currently found when performing subsequent ping queries. 

Options -> Take Screen Capture 

Clicking on the 'Take Screen Capture' option will cause a screenshot of the Rapid-Pair main 

display area to be taken.  The captured screen shot will look similar to Figure 6, but without the 

top or bottom menu items. This screen capture is saved to a Rapid-Pair directory in the current 

user's 'My Documents' folder in a directory named with the date and time of the capture. 
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Options -> Message Window 

Clicking on the 'Message Window' option opens a new window as shown below in Figure 35.  

The message window is used to display Rapid-Pair output messages such as the messages 

displayed when connecting to the dongle, querying SCAN~LINK nodes and updating SCAN~LINK 

node parameters.  The message window is also convenient for checking the completion status 

of Rapid-Pair operations, reporting bugs and for testing connectivity with remote nodes. 

If a message window is currently being displayed, clicking on 'Message Window' again from the 

options menu will close the message window.  The message window can also be closed by 

closing the message window itself by clicking on the 'X' in the upper right hand corner of the 

message window. 

 

Figure 35 - Rapid-Pair message window. 

Like Rapid-Pair, only one message window can be opened and active at any time.  The Rapid-

Pair message window cannot currently be cleared and will continue to accumulate output 

messages.  The message window can only hold the last one hundred messages.  To clear the 

message window of all messages, close an active message window and then reopen a new 

message window by clicking on the 'Message Window' option in the 'Options' drop down menu. 

 

 

 

 

 

 



48 
 

 

3450 LANDMARK RD., BURLINGTON, ONTARIO, CANADA L7M 1S8 
WWW.SCAN-LINK.COM   905-304-6100 | INFO@SCAN-LINK.COM 

 

Help 

Clicking on ‘Help’ in the Rapid-Pair program menu will display a drop down list of additional 

help features available in Rapid-Pair.  The drop down list of additional options includes 'User’s 

Guide', 'Check for Updates', and 'About Rapid-Pair' options as seen below in Figure 36. 

 

Figure 36 - Help Drop Down Menu 

Help -> User’s Guide 

Clicking on 'User’s Guide' under the help menu will display the Rapid-Pair user’s manual.  An 

error message will be displayed indicating that the user’s guide could not be found if the 

manual has been moved or deleted from its default directory location. 

Help -> Check for Updates 

Updates will become available for Rapid-Pair from time-to-time.  These updates will include 

patches to fix Rapid-Pair bugs and updated documentation, add additional Rapid-Pair features,  

or possibly add additional binary image files which can be used to update SCAN~LINK nodes.  If 

an internet connection is present, clicking on the 'Check for Updates' feature under the 'Help' 

drop down menu will cause Rapid-Pair to display an update window that will display status 

messages related to the Rapid-Pair download and update process along with a progress bar. 

Rapid-Pair will first check if a newer version is available from the SCAN~LINK web server.  Rapid-

Pair will then display a status message indicating whether Rapid-Pair is currently up to date and  

the latest version of Rapid-Pair is already installed on the system, as shown below in Figure 37.  

To return to the main Rapid-Pair window, click on the 'Ok' button. 

  

Figure 37 - Rapid-Pair up to date 
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If a newer version of Rapid-Pair is available on the SCAN~LINK web server, Rapid-Pair will begin 

to download the new version and display the download progress percentage and data transfer 

rate as a status message, as shown below in Figure 38. 

  

Figure 38 - Downloading latest version of Rapid-Pair. 

Clicking on the ‘Cancel’ button at any time during the download will stop the current download, 

discard any temporarily downloaded upgrade files and display a status message indicating that 

the download was cancelled.  Click 'Ok' to return to the main Rapid-Pair window. 

Note – It is recommended that the user add an exception for Rapid-Pair in any anti-virus 

software that is currently operating on the system before a Rapid-Pair auto-update.  If this is not 

possible, it is recommended to temporarily disable the anti-virus software until the auto-update 

process has completed.  This will prevent the anti-virus software from interfering with the Rapid-

Pair auto-update process.  Some anti-virus software has been known to block the download and 

remove the Rapid-Pair application all together.  In this event, Rapid-Pair will need to be installed 

again on the system. 

Once the download has completed successfully, the Rapid-Pair updater will display a status 

message which will indicate, “Click Ok to update Rapid-Pair” as can be seen in Figure 39.  

Clicking on the ‘Ok’ button will cause the updater to close the current instance of Rapid-Pair 

and continue with the update.  Clicking on the ‘Cancel’ button will discard the upgrade files and 

return the user to the main Rapid-Pair window. 
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Figure 39 - Ready to continue with upgrade. 

The following prompt may be displayed as shown in Figure 40 below if the upgrade is taking 

place on a Windows system with the UAC (User Account Control) feature enabled.  To continue 

with the Rapid-Pair update, click on “Allow – I trust this program.  I know where it’s from or I’ve 

used it before". 

 

Figure 40 - Windows UAC prompt to update Rapid-Pair. 

Clicking ‘Yes’ will launch the Rapid-Pair updater to update Rapid-Pair to the latest version.  The 

Rapid-Pair updater window is shown below in Figure 41.  The Rapid-Pair updater window will 

list the actions that have been completed during the upgrade. 

The updater will display any errors that have occurred during the update process and will exit if 

an error occurs during the upgrade.  On successful completion, the updater will launch the 

latest version of Rapid-Pair that was downloaded from the SCAN~LINK web server.  Once the 

updated version of Rapid-Pair has been launched, a message window will appear indicating 

whether the upgrade failed or was successful. 
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Figure 41 - Rapid-Pair updater message window shown. 

Help -> About 

Clicking on ‘About’ under the help menu drop down menu item will launch a window to display 

information about the current version of Rapid-Pair.  The information displayed in the about 

window includes the current Rapid-Pair version, build date, author, copyright notice, and a link 

to the SCAN~LINK website. 

Help -> Indicator Codes 

Clicking on ‘Indicator Codes’ under the help drop down menu item will launch a window as seen 

below in Figure 42.  This dialog window can be used by the user to lookup SCAN~LINK indicator 

error codes that are flashing on the front panel display of an indicator node.  The front panel 

LEDs of a SCAN~LINK indicator node is represented within the window graphically as seen 

below in Figure 42.  Clicking within different regions on this graphic will turn on/off the various 

LEDs of the indicator graphic.  An indicator error code can be looked up by clicking the indicator 

graphic LED regions until they match the LEDs found on the actual indicator front panel.   

 

Figure 42 - Indicator Code Window 

The code and reverse input LEDs have on/off states and can be toggled between states by 

clicking within the LED region.  The Tri-LED can be toggled between the green, amber, red and 

off state.  Once the graphical indicator panel's LED states have all been set to match the actual 
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indicator node's LED states, the 'Find Code' button can be clicked to attempt to lookup the 

indicator error code that was entered, as can be seen below in Figure 43.  A brief description of 

a valid error code will be displayed in the 'Description' text box on the dialog window.   

 

Figure 43 - Entered Indicator Error Code 

If an invalid error code has been entered, a message will be displayed in the 'Description' text 

box to indicate that the LED error code entered is invalid, as seen below in Figure 44.  Looking 

up an error code should always be the first step when troubleshooting a SCAN~LINK system 

that is displaying an error code. 

 

Figure 44 - Invalid indicator code entered 

Note - It is possible that a SCAN~LINK indicator may be indicating more than one error code at a 

time.  Multiple error codes may need to be looked up to determine the cause of the system 

error. 
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Viewing a Node’s Properties 
To view additional properties and settings for a SCAN~LINK node, double click on any node that 

is present in the Rapid-Pair main node display area with the left mouse button.  This action will 

launch an additional properties window that contains additional information related to the 

node.  SCAN~LINK indicator and antenna nodes both have different properties available to the 

user for configuration through the use of the node properties window. 

To open the node properties indicator configuration dialog box, double click on an indicator 

node icon in the Rapid-Pair main node display area. The 'Node Properties' window will be 

displayed as shown below in Figure 45. 

The green check boxes on the right hand side of the 'Node Properties' window, as shown in 

Figure 45, indicate that the settings have been read successfully from the node. 

If any of the validation boxes beside a parameter contain an 'X' with a red background, this is an 

indication that the property was either not read back successfully or that the parameter is not 

set correctly.  Properties that do not apply to the indicator node type will contain a gray 'x'. 

Clicking the green box with the arrow (‘Refresh’) in the bottom right hand corner of the 

window, as shown in Figure 45, will attempt to read back the node properties again. 

Clicking the 'Accept' button will save any changes to the indicator node properties that have 

been made for all tabs and clicking the 'Cancel' button will discard any changes.  When any 

node configuration parameters have changed and are pending for a node, the ‘Update’ button 

in the Rapid-Pair toolbar will become active (green).  Clicking the ‘Update’ button will apply the 

node property changes to the node. 



54 
 

 

3450 LANDMARK RD., BURLINGTON, ONTARIO, CANADA L7M 1S8 
WWW.SCAN-LINK.COM   905-304-6100 | INFO@SCAN-LINK.COM 

 

 

Figure 45 - Indicator node properties window. 

When refreshing the node’s configuration properties (by clicking on the green refresh arrow in 

the bottom right corner of the 'Node Properties' window), the refresh process can be cancelled 

by clicking on the ‘X’ button to the right of the refresh button.   

Note that Rapid-Pair will attempt to read back the configuration parameters a number of times 

if the link quality between the dongle and node is poor or interference occurs while Rapid-Pair 

is performing this operation.  Rapid-Pair will eventually stop trying to read the node property 

information after a number of attempts have been performed unsuccessfully. 

Manually Validating a Node Property 

When Rapid-Pair reads the node parameters available in the 'Node Properties' window, a 'valid' 

(green check mark) icon is used to indicate that a parameter was read back successfully.  When 

a parameter was not read back successfully an 'invalid' icon box with a red background that 

contains an 'x' is displayed instead.   

A number of possible conditions exist which may lead to the 'invalid' icon being displayed.  

These conditions include communications loss, cancelling of the operation, or a value was 

returned that did not fall within the acceptable range for the particular parameter.  In order for 

Rapid-Pair to recognize that a parameter has changed in the 'Node Properties' window, the 

parameter must be read back successfully ('valid' icon) before being changed and the ‘Accept’ 

button must be clicked on.  Clicking on the 'Accept' button will process any changes and enable 

the 'Update' button in the main Rapid-Pair window.  This behaviour is implemented to prevent 

Rapid-Pair from updating a node parameter that may contain an invalid/unacceptable value. 
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For example, if an indicator node is double clicked on from the main Rapid-Pair node display 

area, the 'Node Properties' window will be displayed.  If the 'Reverse Input' parameter is not 

read back correctly, the 'invalid' icon will be displayed next to the parameter to indicate an 

error occurred when reading back the parameter.  Any changes made to this parameter will not 

be accepted when clicking on the 'Accept' button.  Changes to this parameter will only be 

accepted after the parameter has been successfully read back and changed. 

This behaviour presents a problem when commissioning SCAN~LINK nodes since some of the 

node parameters have default values that will cause Rapid-Pair to 'invalidate' the parameter 

when read back for the first time.  To solve this problem, any 'invalid' icon can be double clicked 

on to manually validate the parameter.  A message window will appear as seen in Figure 46 

below asking if the parameter should be validated.  Clicking 'Yes' will cause Rapid-Pair to accept 

the parameter change even though the parameter was not read back by Rapid-Pair successfully. 

 

 

Clicking on ‘Ok’ will manually validate the parameter, while clicking on ‘Cancel’ will cancel the 

operation.  Once a parameter has been validated, the icon beside the configuration parameter 

being validate will changed to display an 'X' with a green background. 

 

 

 

 

 

 

 

 

Figure 46 - Manual Parameter Validation Window 
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Indicator Node Properties 

This section will cover the properties and parameters available specifically to SCAN~LINK 
indicator nodes and the settings required to configure a SCAN~LINK indicator node during an 
installation. 

Configuration Tab 

The configuration tab is the first tab of the ‘Node Properties’ window that the user will see once 

a node has been double clicked on.  A number of parameters are available to be modified in 

this tab and include the following parameters. 

Channel:  

The channel that the node communicates on can be changed here.  Channels zero to fifteen are 

available to choose from.  Unlike the network ID, this channel selection provides a physical 

separation of communication.  

Changing channels may be necessary for several reasons.  If there are many systems installed in 

close proximity to each other there is a chance that wireless collisions may occur.  This will 

cause the status LED (green LED) on indicator nodes to flash amber and indicates a 

communication error.  Putting these units on separate channels, or decreasing the number of 

units per channel will help resolve this problem. 

Interference is another possible reason why the system's operating channel may need to be 

adjusted.  If there are other third party nodes in the area of operation which are operating in 

the 2.4GHz band, these third party nodes may cause communication problems if the power 

output of the node(s) is high enough.  One example of this would be if the SCAN~LINK nodes 

are operating near a powerful Wi-Fi hotspot.  Since 802.11 Wi-Fi is also a 2.4 GHz channel based 

technology, moving to a different channel may likely resolve such an interference issue. 

Note - If there is very strong interference which is causing a complete communications failure of 

the SCAN~LINK system, the SCAN~LINK units may have to be moved out of the area which 

contains the interference in order to allow Rapid-Pair to communicate with the nodes properly 

again so that the channel parameter can be changed. 

RS485 Address: 

This parameter changes the RS485 network address that the node will listen on for commands.  

This parameter can be set but is only used by SCAN~LINK nodes that are operating and listening 

for RS485 command messages. 

Network ID: 

This parameter changes which network the SCAN~LINK node is operating on.  If nodes are not 

on the same network (having the same network ID) they will not be able to communicate with 

each other.  If Rapid-Pair cannot communicate with a node because it is on a different network, 
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the network ID of the dongle must be changed first to the network ID of the node before the 

network ID of the node can be changed.  The network ID can also be extracted from the serial 

numbers that are on the SCAN~LINK units.  

Note – Changing the network ID between nodes will not prevent wireless collisions from 

occurring if the nodes are on the same channel. 

MAC Address:  

This field will already be set by default.  MAC addresses are a globally licensed unique ID and 

should not be changed.  Changing the address could potentially cause communication problems 

with the SCAN~LINK system or surrounding nodes. 

Reverse Input:  

The reverse input line on a SCAN~LINK system determines whether the SCAN~LINK system is 

detecting RFID tags.  The reverse input signal can come from either the antenna or indicator 

node and this will have to be set upon commissioning a system.  Set this option to enabled if 

the reverse input signal comes from the SCAN~LINK node that is currently being configured. Set 

this option to disabled if the reverse input is not being used on the node that is being 

configured. 

Note – Do not attempt to use both reverse inputs on a set of paired nodes.  One reverse input 

line should always be disabled on a set of paired antenna and indicator nodes. 

Comm Err Beep:  

The indicator node will always display a green light if communications between it and the 

antenna are maintained. The SCAN~LINK system is always monitoring the integrity of the 

communications link through a periodic heartbeat. The green light on the indicator front panel 

display will change to a flashing amber state if this heartbeat stops being received.  A 

communications error may depend on the mounting location of the indicator node, or other 

obstructions inside the vehicle, and may not be apparent to the operator.  Changing this setting 

to enabled will add an audible alarm when the tri-state LED on the indicator node flashes 

amber, indicating that a communications timeout has occurred. 
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Marker Tag Alert:  

For antenna and indicator nodes that support marker tag detection, setting this option to 

enabled will cause the indicator node to beep with a different frequency instead of the regular 

alarm frequency when marker tags are detected by the antenna node.  Regular shorter range 

tags detected by the antenna node will still cause the indicator node to beep with the regular 

alarm and beep frequency.  When set to disabled, both long range and short range tags will set 

off the same alert on the indicator.  Setting this parameter to enabled will have no effect on 

indicator or antenna nodes that do not support long range tag detection. 

Firmware Version:  

This is the version and release date of the firmware that is running on the wireless module of 

the SCAN~LINK indicator node.  

CRC (Cyclic Redundancy Check): 

This is the CRC value that is computed on the SCAN~LINK node firmware scripts by the 

underlying embedded operating system of the SCAN~LINK nodes.  This check is performed to 

ensure that the script has been uploaded to the node successfully.  This value can also be used 

to help determine what version of a script has been uploaded to the SCAN~LINK node. 

Script:   

This is the name of the binary image that is currently operating on the SCAN~LINK node.  This 

script name can also be used to identify the node type and the build date. 
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Installation Tab 

Clicking on the Installation tab in the 'Node Properties' window will display the 'Installation' tab, 

as shown below in Figure 47.  The fields on this tab have no effect on the operation of the 

system. These fields can be changed for your convenience in order to help identify the vehicle 

that the system is installed on.  They also provide a way for keeping notes about the vehicle or 

system the SCAN~LINK nodes are installed on. 

 

Figure 47 - Node properties installation tab shown. 

VIN: 

The vehicle identification number or 'VIN' field is used to enter a unique number that can be 

used to identify an antenna node that is being deployed.  This field is limited to 10 digits and 

the default value of the field is 'None'. 

Installation Type: 

The 'Installation Type' field is used for tracking the physical location on a vehicle where the 

antenna node is being installed.  The default value of the field is 'None'. 

Vehicle Type: 

The 'Vehicle Type' field is used for tracking the type of vehicle that the antenna node has been 

installed on.  The default value of the field is 'None'. 

Service Notes: 

The 'Service Notes' field allows the installer to enter additional information about the antenna 

node installation.  The default value of the field is 'None'. 
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Security Tab 

Clicking on the 'Security' tab in the 'Node Properties' window for an indicator node will display 

the following tab as seen below in Figure 48.  The 'Network Key' configuration parameter allows 

the user to enter a secret key that will be used by the indicator node to communicate with any 

paired antenna nodes that also support this security feature.  The 'Network' tab within the 

'Node Properties' dialog window will not be available to use with indicator nodes that do not 

support the additional security features. 

Nodes that support additional security are only able communicate with other nodes that 

support the same security features.  SCAN~LINK nodes that do not support additional security 

cannot communicate with nodes that do support the additional security. 

Each indicator node that supports the additional security feature uses a pre-defined default 

network key.  The network key must be set to the same key value on all nodes that the 

indicator node is required to communicate with.  If the indicator node supports the additional 

security features, the default key will be used by the Rapid-Pair application to communicate 

with the indicator node.  The network key feature will not be available to use with indicator 

nodes that do not support the additional security features. 

 

Figure 48 - Indicator Node Security Tab 

To change the indicator node 'Network Key' parameter, click in the text field and enter a 

security key up to thirty-one characters long into the text field.  For security reasons, the 

characters will not be displayed and ten characters will always be displayed in the text field for 

added security.  If a new network key value has been entered into the textbox field and the 
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'Accept' button in the dialog window is clicked, a prompt will be displayed indicating that the 

network key has changed, as seen below in Figure 49.  

 

Figure 49 - Confirm Indicator Node Network Key 

Clicking 'Yes' on the 'Confirm Network Key' dialog box window will update the network key that 

the indicator will use once the 'Update' button is clicked on and return the user to the main 

Rapid-Pair window.  Clicking 'No' on the 'Confirm Network Key' dialog box will disregard any 

changes that were made to the indicator node's network key and return the user to the main 

Rapid-Pair window, however, additional changes made to any indicator node configuration 

parameters will be kept, and will be applied to the indicator if the user clicks on the 'Update' 

button.  

Unlike the dongle, changing the network key of an indicator node will not take effect 

immediately.  Therefore, the user will still have a chance to configure the indicator node's 

parameters again before having to change the network key of the dongle to match the same 

network key that was applied to the indicator node before being able to communicate with the 

updated indicator again. 

Note - There is currently no way to recover a network key if it is lost.  Therefore, it is left up to 

the user to keep track of any network keys that have been assigned to SCAN~LINK nodes.  Please 

contact a SCAN~LINK representative if an assigned network key has been lost. 
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Antenna Node Properties 

This section will cover the properties available specifically to SCAN~LINK antenna nodes and the 
settings required to configure a SCAN~LINK antenna node during an installation. 

Configuration Tab 

Double click on the antenna node icon in the Rapid-Pair main node display area to open the 

'Node Properties' window for an antenna node.  The 'Configuration' tab will be displayed by 

default, as shown below in Figure 50. 

The green check boxes on the right hand side of the 'Node Properties' window for the antenna 

node, as shown in Figure 50, indicate that the settings have been read successfully from the 

remote node.  If the boxes contain an 'X' with a red background, the property was not read 

back successfully.  Properties that do not apply to the node type are indicated with an 'X' with a 

gray background.  Clicking the green refresh box with the arrow in the bottom right of the 

window will read back the properties again. 

Clicking the 'Accept' button will save any changes to the node properties that have been made 

and clicking the 'Cancel' button will discard any changes.  The 'Update' button at the top of the 

node view window will become active (green) when there are changes pending for a node 

property.  Clicking on this button will write the property changes to the node. 

 

Figure 50 - Antenna node configuration tab shown. 

The properties that are visible on the configuration tab for antenna nodes are the same as the 

properties that are visible for indicator nodes.  The only differences between an antenna node's 

available 'Configuration' tab properties and an indicator node's 'Configuration' tab properties is 
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that the communications error beep and long range alert properties have been disabled for 

antenna nodes since antenna nodes do not make use of either of these properties.  A box with 

a gray background that contains an ‘x’ will appear beside these properties instead of a box with 

a green background and checkmark or red background and 'x'.  This gray box indicates that 

these properties are not a feature of the antenna node and cannot be queried or updated. 

Please see the previous 'Configuration' tab section of the user manual for indicator for a 

description of the available configuration parameters that are available in the 'Configuration' 

tab. 
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Installation Tab 

Clicking on the 'Installation' tab in the 'Node Properties' window for an antenna node will 

display and allow modifications of all the displayed fields as shown below in Figure 51.  These 

fields have no effect on the operation of the system and these fields provide additional 

information about the vehicle or system the SCAN~LINK antenna node is installed on. 

 

Figure 51 - Antenna Node Installation Tab 

VIN: 

The vehicle identification number or 'VIN' field is used to enter a unique number that can be 

used to identify an antenna node that is being deployed.  This field is limited to 10 digits.  The 

default value of the field is 'None'.   

Installation Type: 

The 'Installation Type' field is used for tracking the physical location on a vehicle where the 

antenna node is being installed.   

Vehicle Type: 

The 'Vehicle Type' field is used for tracking the type of vehicle that the antenna node has been 

installed on. 

Service Notes: 

The 'Service Notes' field allows the installer to enter additional information about the antenna 

node installation. 
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Operation Tab 

Clicking the 'Operation' tab in the 'Node Properties' dialog window will display the antenna 

operation parameters for a SCAN~LINK antenna node, as shown below in Figure 52.  These 

parameters allow the user to fine tune the detection performance of an antenna node. 

The power level and frequency range configuration settings are not universal across all 

installations of SCAN~LINK antenna nodes.  Many of the settings will not require any additional 

modifications in most cases as these parameters have been preconfigured at the time the 

antenna node was manufactured and tested.  The antenna 'Power Output' parameter is the 

only setting that may require further adjustment when installing a SCAN~LINK system.   

Note - A SCAN~LINK system's detection capabilities should be tested with SCAN~LINK Armour 

apparel after any of these parameters have been changed.  The detection range and efficiency 

of the SCAN~LINK system should also be re-evaluated by testing the SCAN~LINK system. 

 

Figure 52 - Antenna node operation tab shown. 

Scan Hold-off: 

The scan hold-off configuration setting allows the random scanning hold-off time to be 

adjusted.  This configuration parameter controls the scanning rate with which the antenna 

node will scan for SCAN~LINK apparel.  The scan hold-off drop down box allows the following 

options to be selected, Half / Default / Double / Triple.  Selecting 'Half' will effectively increase 

the antenna node scanning rate by a factor of two compared to the default scanning rate.  

Selecting 'Double' and 'Triple' will effectively reduce the antenna node scanning rate by a factor 
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of two and three when compared to the default scanning rate.  It is recommended that the scan 

hold-off parameter be configured with the 'Default' setting. 

Note - Adjusting the scan hold-off configuration parameter will cause additional RF interference 

to occur if configured to operate at an increased scanning rate and may decrease the detection 

capabilities of additional nearby SCAN~LINK systems. 

Multiplexer Lines: 

SCAN~LINK multi-antenna node units will require this setting to be adjusted in order to take 

advantage of any additional antennas that have been connected to the antenna node.  The 

value of this configuration parameter should be set to the number of antennas that have been 

connected to the multi-antenna node.  For a regular SCAN~LINK antenna node, this parameter 

should be set to the default value of 1. 

Start-up Mode: 

The start-up mode configuration parameter determines which of the two operational states the 

antenna node will enter into once the antenna's start-up sequence has completed.  The two 

available start-up modes are the apparel scanning and diagnostic scanning modes.  When in the 

apparel scanning mode, the antenna node will scan for SCAN~LINK apparel and notify a paired 

SCAN~LINK indicator node if any detections occur.  The diagnostic scanning mode allows the 

antenna node to scan for an internal diagnostic tag which is used to test the antenna's 

detection capabilities. 

Note - This configuration parameter applies only during the absence of a reverse input signal.  

Refer to Table 3 below to determine when the 'Start-up Mode' configuration parameter is used 

by the SCAN~LINK antenna node. 

 Indicator 
(Unpaired) 

Indicator (Paired) 
(Reverse-Input Enabled) 

Indicator (Paired) 
 (Reverse-Input Disabled) 

Antenna 
Rev-In Enabled 

Uses antenna's 
reverse input line. 

Uses antenna's 
reverse input line. 

Uses antenna's 
reverse input line. 

Antenna 
Rev-In Disabled 

Uses Start-Up mode 
parameter setting. 

Uses indicator's 
reverse input line. 

Uses Start-Up mode 
parameter setting. 

Table 3 - Start-up mode parameter 

Power Output:  

The power output of the antenna node can range from 10.0 dBm to 30.0 dBm.  Note that a dBm 

is the power ratio in decibels referenced to one milliwatt.  The available power range also 

depends on the type of RFID reader that is part of the SCAN~LINK antenna node and the 

regulatory region that the antenna node has been configured for.  Varying the power will 

directly affect the physical range over which a SCAN~LINK antenna can detected RFID equipped 
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apparel.  The SCAN~LINK systems will already be set with a power level that was determined 

during quality control testing and should not typically need to be changed. 

The detection range will have to be verified again after the unit is installed.  You may find that 

the detection zone may be too small or too big after an installation.  Adjustments should be 

made incrementally if necessary.  Sometimes less than a ±0.5 dBm adjustment is enough to 

increase/decrease the detection zone by a few feet.  The slider tab for the power level 

parameter can be incremented and decremented with finer resolution by clicking on the slider 

tab and then moving the tab by pressing the left and right arrow keys on the keyboard. 

Modulation Depth:  

Modulation depth is a characteristic of how the RFID reader communicates with the passive 

RFID tags that are part of SCAN~LINK apparel. Normally setting this to 70% provides the best 

detection performance when operating in and around the 20-27 dBm range.  The modulation 

depth value can only be incremented and decremented in multiples of 10%. 

Minimum Frequency:  

Modifying this setting will change the lower limit of the frequency range that the SCAN~LINK 

antenna will operate randomly within.  This value is incremented and decremented by clicking 

on the slider bar tab with the mouse and dragging the slider to the desired frequency.  The 

slider tab for the minimum frequency can be incremented and decremented with finer 

resolution by first clicking on the slider tab followed by pressing the left and right arrow keys on 

the keyboard.  

Maximum Frequency:  

Modifying this setting will change the upper limit of the frequency range that the SCAN~LINK 

antenna will operate randomly within.  The slider tab for the maximum frequency can be 

incremented and decremented with finer resolution by first clicking on the slider tab followed 

by pressing the left and right arrow keys on the keyboard. 

Current Frequency:  

This is the frequency setting at which the SCAN~LINK antenna will begin a random hopping 

sequence. This value has little effect on the actual detection performance as the random 

frequency hops occur often.  The slider tab for the current frequency can be incremented and 

decremented with finer resolution by first clicking on the slider tab followed by pressing the left 

and right arrow keys on the keyboard. 
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Dual Node Operation Tab 

When a dual node antenna unit is double clicked on, the node properties window will be 

displayed.  Clicking the 'Operation' tab in the 'Node Properties' dialog window will display the 

antenna operation parameters for a SCAN~LINK dual node antenna, as shown below in Figure 

53.  These parameters allow the user to fine tune the detection performance of a dual node 

antenna. 

 

Figure 53 - Dual node antenna operation tab shown 

The 'Operation' tab in the 'Node Properties' dialog window contains the same properties that 

are available for a regular antenna node, however, the 'Power Output' property has been 

replaced with two additional properties named 'Left Power Level' and 'Right Power Level' for 

dual node antennas. 

Left / Right Power Level: 

The 'Left Power Level' and 'Right Power Level' properties determine the output power level of 

the left and right antennas in a dual node antenna system.  These properties have the same 

effect on the detection range of apparel as the 'Power Output' property for a regular antenna 

node. 

The power output of the dual antenna node can range from 10.0 dBm to 30.0 dBm.  The 

available power range also depends on the type of RFID reader that is part of the SCAN~LINK 

dual node antenna and the regulatory region that the dual node antenna has been configured 

for.  Varying the left or right power level will directly affect the physical range over which a 

SCAN~LINK dual node antenna can detect RFID equipped apparel. 
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Diagnostics Tab 

The 'Diagnostics' tab in the node properties window applies to antenna nodes only and can be 

seen below in Figure 53.  This configuration tab allows the antenna node's self diagnostic 

features to be configured.  These configuration properties will normally be set up at the time of 

manufacture and quality control testing, and generally should not need to be modified while 

installing a SCAN~LINK system. 

All antenna nodes are fitted with a unique internal diagnostic tag that is periodically read back 

during antenna operation.  The purpose of this periodic diagnostic tag read is to test if the 

internal RFID reader is functioning correctly or is no longer capable of detecting RFID equipped 

apparel.  If the RFID reader can no longer detect the internal diagnostic tag, an error code will 

be displayed on the paired indicator's front panel display. 

 

Figure 53 - Antenna node diagnostics tab shown. 

Threshold:  

The threshold parameter specifies the number of consecutive failed internal diagnostic tag read 

attempts that are allowed before registering a diagnostic detection error to the paired indicator 

node. 

For example, in Figure 53, the setting is currently twenty, which is the default threshold value 

for newer antenna nodes. The internal RFID tag is read at periodic intervals when the antenna 

node is not actively scanning for SCAN~LINK apparel.  If the antenna node does not read an 

internal tag back that contains the matching unique universal ID within the number of attempts 

specified by this setting, an error will be displayed on the paired indicator front panel display.  



70 
 

 

3450 LANDMARK RD., BURLINGTON, ONTARIO, CANADA L7M 1S8 
WWW.SCAN-LINK.COM   905-304-6100 | INFO@SCAN-LINK.COM 

 

Adjusting this threshold may be necessary if it is observed that the display unit is displaying an 

internal tag error intermittently.  Setting the value of this property to zero will disable the 

periodic internal tag check. 

Universal ID:  

This configuration parameter is the unique universal ID of the internal tag that resides inside of 

the antenna node and is unique for each antenna node.  Clicking the refresh button beside the 

'Universal ID' field will return the last internal tag UID read by the antenna.  This is a convenient 

way to read the internal tag for an antenna node should the UID be changed to a value other 

than the original UID. 

Note - Changing the UID value to a value other than the value specified during manufacture for 

antenna nodes operating with older firmware versions may cause the internal tag test to fail.   

The internal unique RFID tag UID cannot be found on the serial number labels of either the 

antenna or indicator nodes.  Antenna nodes operating with a newer firmware version may not 

be able to read back the UID value, instead a 16 digit null value is return by the antenna node. 

Detect Power:  

The 'Detect Power' configuration parameter adjusts the power level in the same manner as the 

‘Power Output’ slider found in the operation tab, except the power level adjusted is the power 

level that is used to read the internal diagnostic tag.  The power level required to detect a 

diagnostic tag is lower than the power level setting for SCAN~LINK apparel since the internal 

diagnostic tag is in closer proximity to the antenna node.  Generally this value is set during the 

time of manufacture and quality control testing and should not need to be changed. 

Increasing this value may only be necessary if increasing the threshold property fails to resolve 

problems with intermittent diagnostic tag error codes being displayed on a paired indicator 

unit.  The installation environment may have an effect on the internal diagnostic tag read 

performance, requiring the adjustment of the detection power.  The slider tab for the detection 

power can be incremented and decremented with finer resolution by first clicking on the slider 

tab followed by pressing the left and right arrow keys on the keyboard. 
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Dual Node Diagnostics Tab 

When a dual node antenna unit is double clicked on, the node properties window will be 

displayed.  Clicking the 'Diagnostics' tab in the 'Node Properties' dialog window will display the 

antenna diagnostic parameters for a SCAN~LINK dual node antenna, as shown below in Figure 

54.  This configuration tab allows the dual node antenna self diagnostic features to be 

configured.  These configuration properties will normally be set up at the time of manufacture 

and quality control testing, and generally should not need to be modified while installing a 

SCAN~LINK system. 

 

Figure 54 - Dual Node Antenna diagnostics tab shown. 

The 'Diagnostics' tab in the 'Node Properties' dialog window contains the same properties that 

are available for a regular antenna node, however, the 'Detect Power' property has been 

replaced with two additional properties named 'Left Power Level' and 'Right Power Level' for 

dual node antennas. 

Left / Right Power Level:  

The 'Left Power Level' and 'Right Power Level' properties adjust the diagnostic power levels for 

the left and right nodes of the dual node antenna in the same manner as the ‘Power Output’ 

slider found in the operation tab, except the power level adjusted is the power level that is 

used to read the internal diagnostic tag.  The power level required to detect a diagnostic tag is 

lower than the power level setting for SCAN~LINK apparel since the internal diagnostic tag is in 

closer proximity to the antenna node.  Generally this value is set during the time of 

manufacture and quality control testing and should not need to be changed. 
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Security Tab 

Clicking on the 'Security' tab in the 'Node Properties' window for an antenna node will display 

the following tab as seen below in Figure 55.  The 'Network Key' configuration parameter allows 

the user to enter a secret key that will be used by the antenna node to communicate with any 

paired antenna nodes that also support this security feature.  This tab is only available for 

antenna nodes that support the additional security features. 

Nodes that support additional security are only able communicate with other nodes that 

support the same security features.  SCAN~LINK nodes that do not support additional security 

cannot communicate with nodes that do support the additional security. 

Each antenna node that supports the additional security feature uses a pre-defined default 

network key.  The network key must be set to the same key value on all nodes that the antenna 

node is required to communicate with.  If the antenna node supports the additional security 

features, the default key will be used by the Rapid-Pair application to communicate with the 

antenna node.  The network key tab within the 'Node Properties' dialog window will not be 

available to use with antenna nodes that do not support the additional security features. 

 

Figure 55 - Antenna Node Security Tab 

To change the antenna node 'Network Key' parameter, click in the text field and enter a security 

key up to thirty-one characters long into the text field.  For security reasons, the characters will 

not be displayed and ten characters will always be displayed in the text field for added security.  

If a new network key value has been entered into the textbox field and the 'Accept' button in 
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the dialog window is clicked, a prompt will be displayed indicating that the network key has 

changed, as seen below in Figure 56. 

 

Figure 56 - Confirm Antenna Node Network Key 

Clicking 'Yes' on the 'Confirm Network Key' dialog box window will update the network key that 

the antenna will use once the 'Update' button is clicked on and return the user to the main 

Rapid-Pair window.  Clicking 'No' on the 'Confirm Network Key' dialog box will disregard any 

changes that were made to the antenna node's network key and return the user to the main 

Rapid-Pair window, however, additional changes made to any antenna node configuration 

parameters will be kept, and will be applied to the antenna if the user clicks on the 'Update' 

button.  

Unlike the dongle, changing the network key of an antenna node will not take effect 

immediately.  Therefore, the user will still have a chance to configure the antenna node's 

parameters again before having to change the network key of the dongle to match the same 

network key that was applied to the antenna node before being able to communicate with the 

updated antenna again. 

Note - There is currently no way to recover a network key if it is lost.  Therefore, it is left up to 

the user to keep track of any network keys that have been assigned to SCAN~LINK nodes.  Please 

contact a SCAN~LINK representative if an assigned network key has been lost. 

 

 


